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1 Introduction
1.1 General Information

The CamBuilder is a tool integrated into the IndraWorks Engineering Desktop
for the simple and convenient creation of electronic cams. The CamBuilder
supports the direct downloading of cams to the Bosch Rexroth drive controllers,
with the result that this tool is specific and predestined for its requirements and
special features.

1.2 Cams and Synchronization Modes
Electronic cams control the motion sequences of slave axes in relation to mas‐
ter axes.
The Bosch Rexroth driver controllers have different synchronization modes for
executing cams.
Cam table The position of the slave axis is calculated during its runtime

using the distance and the percentage values from the table.
MotionProfile The position of the slave axis is calculated during its runtime

using analytical functions or cam tables.
FlexProfile The FlexProfile corresponds to an extension of the MotionPro‐

file (the time can optionally be used as a reference variable for
the slave axis; it has a larger choice of motion laws and an
event controller).

The CamBuilder is a higher-level tool and, during creation and editing, does not
differentiate between the various operation modes. Only if the user decides to
download a cam onto a device, he has to specify the corresponding operation
mode.

1.3 CamBuilder - Features
The essential features of the CamBuilder are as follows:
● Simple creation of cams using graphic tools
● Convenient editing of existing cams
● Open several cams parallely in a preview and analyze them with different

master axis velocities
● Use of VDI 2143-compliant motion laws
● Upload and download cams to Bosch Rexroth drives and controls
● Generating an PLC code to change the cam in the PLC program at run‐

time.
● Automatic display of position, acceleration, velocity and jerk
● Support for common requirements (application-specific cams, such as

CrossCutter) with wizards
● Import of cam tables as motion law
● Automatic recognition and calculation of the limit conditions of the indi‐

vidual motion steps of the cam
● Zoom functions
● Import / export functionality in different formats (*.XML, *.PAR, *.CSV).
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1.4 Definition of Terms
Cam

Fig.1-1: Diagram of a cam graph to provide a definition of terms
(a) Master axis (X-axis)
(b) Slave axis (Y-axis)
(c) Motion steps (1 – n)
(d) Focused motion step
(e) Motion law (analytical function or cam table)
(f ) Starting point of the focused motion step (Xn,Yn)
(g ) End point of the focused motion step (Xn+1,Yn+1)
(h) Distance of the focused motion step (ΔY)
(i ) Range of the focused motion step, which can either be the time duration
(ΔT) or the master axis range (ΔX).
A cam defines the position of a slave axis in relation to a master axis or in
relation to the time. A cam comprises one or more motion steps. Each motion
step has a motion law that specifies the connection between the master axis or
time and the slave axis. The individual motions of the steps create a cam.
In the CamBuilder, the focused motion step of a cam is always edited. This can
either take place via a graphic diagram or via numerical inputs. Depending on
the editing mode and the type of change, the preceding or subsequent motion
steps can also change.
From the second motion step on, all motion steps begin with the end point of
the preceding step.
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2 Important Instructions for Use
2.1 Intended Use
2.1.1 Introduction

All Bosch Rexroth controls and drives are developed and tested in accordance
with the state of the art.
As it is however impossible to follow up the ongoing development of all materials
with which our controls and drives may come into contact (e.g. lubricants at
machine tools), reactions with the materials used in our systems cannot be
generally excluded.
For this reason, before using new lubricants, cleaning agents etc., it has to be
ensured that they are compatible with the materials of our housings and devi‐
ces.
The products may only be used in the proper manner. If they are not used as
intended, situations may arise that can lead to personal injury or damage to
property.

Bosch Rexroth, as the manufacturer of the products, will not as‐
sume any warranty, liability or payment of damages in case of
damage resulting from a non-intended use of the products. If he
fails to use the products as intended, the user will be solely respon‐
sible for any resulting risks.

Before using the Bosch Rexroth products, the following prerequisites must be
fulfilled to ensure that they are used as intended:
● Any person who in any way whatsoever is involved in handling our prod‐

ucts must read and understand the corresponding safety instructions and
the notes on intended use.

● To the extent that the products are hardware elements, they must be left
in their original state; i.e. no structural modifications must be carried out.
Software products must not be decompiled and the source codes must
not be modified.

● Damaged or defective products must neither be installed nor be put into
operation.

● It must be guaranteed that the products are installed according to the in‐
structions mentioned in the documentation.

2.1.2 Scope of Use and Application
Bosch Rexroth drive controllers are intended to control electrical motors and
monitor their operation.
To control and monitor the motor, it may be necessary to connect additional
sensors and actuators.

The drive controllers must only be used with the accessories and
mounting parts listed in this Documentation. Components that are
not expressly mentioned must neither be attached nor connected.
The same is valid for cables and lines.
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The operation must only be carried out with the component config‐
urations and combinations that were expressly mentioned and with
the software and firmware indicated and specified in the respective
functional description.

Before commissioning, every drive controller must be programmed to ensure
that the motor executes the appropriate functions for the application.
The drive controllers have been developed for use in single and multi-axes drive
and control tasks.
To allow for application-specific requirements in the drive controllers, our prod‐
uct range comprises various device types with different drive powers and
interfaces.
The drive controller must be operated only in the mounting and installation
conditions, the position, and the ambient conditions (temperature, degree of
protection, moisture, EMC, etc.) specified in this Documentation.

2.2 Improper Use
Use of the drive controllers in applications other than those specified or descri‐
bed in the documentation and technical data is considered as "improper".
Drive controllers must not be used if they …
● are exposed to operating conditions which do not correspond to the speci‐

fied ambient conditions. Operation under water, under extreme tempera‐
ture fluctuations or extreme maximal temperatures etc. is prohibited.

● Furthermore, the drive controllers must not be used in any applications
not expressly approved by Bosch Rexroth. For this, please read the state‐
ments given in the general safety instructions!
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3 Safety Instructions for Electric Drives and Controls 
3.1 Definitions of Terms

Application Documentation Application documentation comprises the entire documentation used to inform
the user of the product about the use and safety-relevant features for config‐
uring, integrating, installing, mounting, commissioning, operating, maintaining,
repairing and decommissioning the product. The following terms are also used
for this kind of documentation: User Guide, Operation Manual, Commissioning
Manual, Instruction Manual, Project Planning Manual, Application Manual, etc.

Component A component is a combination of elements with a specified function, which are
part of a piece of equipment, device or system. Components of the electric drive
and control system are, for example, supply units, drive controllers, mains
choke, mains filter, motors, cables, etc.

Control System A control system comprises several interconnected control components placed
on the market as a single functional unit.

Device A device is a finished product with a defined function, intended for users and
placed on the market as an individual piece of merchandise.

Electrical Equipment Electrical equipment encompasses all devices used to generate, convert, trans‐
mit, distribute or apply electrical energy, such as electric motors, transformers,
switching devices, cables, lines, power-consuming devices, circuit board as‐
semblies, plug-in units, control cabinets, etc.

Electric Drive System An electric drive system comprises all components from mains supply to motor
shaft; this includes, for example, electric motor(s), motor encoder(s), supply
units and drive controllers, as well as auxiliary and additional components, such
as mains filter, mains choke and the corresponding lines and cables.

Installation An installation consists of several devices or systems interconnected for a de‐
fined purpose and on a defined site which, however, are not intended to be
placed on the market as a single functional unit.

Machine A machine is the entirety of interconnected parts or units at least one of which
is movable. Thus, a machine consists of the appropriate machine drive ele‐
ments, as well as control and power circuits, which have been assembled for
a specific application. A machine is, for example, intended for processing,
treatment, movement or packaging of a material. The term "machine" also cov‐
ers a combination of machines which are arranged and controlled in such a way
that they function as a unified whole.

Manufacturer The manufacturer is an individual or legal entity bearing responsibility for the
design and manufacture of a product which is placed on the market in the in‐
dividual's or legal entity's name. The manufacturer can use finished products,
finished parts or finished elements, or contract out work to subcontractors.
However, the manufacturer must always have overall control and possess the
required authority to take responsibility for the product.

Product Examples of a product: Device, component, part, system, software, firmware,
among other things.

Project Planning Manual A project planning manual is part of the application documentation used to
support the sizing and planning of systems, machines or installations.

Qualified Persons In terms of this application documentation, qualified persons are those persons
who are familiar with the installation, mounting, commissioning and operation
of the components of the electric drive and control system, as well as with the
hazards this implies, and who possess the qualifications their work requires. To
comply with these qualifications, it is necessary, among other things,
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1) to be trained, instructed or authorized to switch electric circuits and devices
safely on and off, to ground them and to mark them
2) to be trained or instructed to maintain and use adequate safety equipment
3) to attend a course of instruction in first aid

User A user is a person installing, commissioning or using a product which has been
placed on the market.

3.2 General Information
3.2.1 Using the Safety Instructions and Passing Them on to Others

Do not attempt to install and operate the components of the electric drive and
control system without first reading all documentation provided with the product.
Read and understand these safety instructions and all user documentation prior
to working with these components. If you do not have the user documentation
for the components, contact your responsible Bosch Rexroth sales partner. Ask
for these documents to be sent immediately to the person or persons respon‐
sible for the safe operation of the components.
If the component is resold, rented and/or passed on to others in any other form,
these safety instructions must be delivered with the component in the official
language of the user's country.
Improper use of these components, failure to follow the safety instructions in
this document or tampering with the product, including disabling of safety de‐
vices, could result in property damage, injury, electric shock or even death.
 

3.2.2 Requirements for Safe Use
Read the following instructions before initial commissioning of the components
of the electric drive and control system in order to eliminate the risk of injury
and/or property damage. You must follow these safety instructions.
● Bosch Rexroth is not liable for damages resulting from failure to observe

the safety instructions.
● Read the operating, maintenance and safety instructions in your language

before commissioning. If you find that you cannot completely understand
the application documentation in the available language, please ask your
supplier to clarify.

● Proper and correct transport, storage, mounting and installation, as well
as care in operation and maintenance, are prerequisites for optimal and
safe operation of the component.

● Only qualified persons may work with components of the electric drive and
control system or within its proximity.

● Only use accessories and spare parts approved by Bosch Rexroth.
● Follow the safety regulations and requirements of the country in which the

components of the electric drive and control system are operated.
● Only use the components of the electric drive and control system in the

manner that is defined as appropriate. See chapter "Appropriate Use".
● The ambient and operating conditions given in the available application

documentation must be observed.
● Applications for functional safety are only allowed if clearly and explicitly

specified in the application documentation "Integrated Safety Technolo‐
gy". If this is not the case, they are excluded. Functional safety is a safety

Bosch Rexroth AG  DOK-IWORKS-CAMBUIL*V10-FK02-EN-P
 Rexroth IndraWorks  10VRS CamBuilder

10/103

Safety Instructions for Electric Drives and Controls



concept in which measures of risk reduction for personal safety depend
on electrical, electronic or programmable control systems.

● The information given in the application documentation with regard to the
use of the delivered components contains only examples of applications
and suggestions.
The machine and installation manufacturers must
– make sure that the delivered components are suited for their individ‐

ual application and check the information given in this application
documentation with regard to the use of the components,

– make sure that their individual application complies with the appli‐
cable safety regulations and standards and carry out the required
measures, modifications and complements.

● Commissioning of the delivered components is only allowed once it is sure
that the machine or installation in which the components are installed
complies with the national regulations, safety specifications and standards
of the application.

● Operation is only allowed if the national EMC regulations for the applica‐
tion are met.

● The instructions for installation in accordance with EMC requirements can
be found in the section on EMC in the respective application documenta‐
tion.
The machine or installation manufacturer is responsible for compliance
with the limit values as prescribed in the national regulations.

● The technical data, connection and installation conditions of the compo‐
nents are specified in the respective application documentations and must
be followed at all times.

National regulations which the user must take into account
● European countries: In accordance with European EN standards
● United States of America (USA):

– National Electrical Code (NEC)
– National Electrical Manufacturers Association (NEMA), as well as

local engineering regulations
– Regulations of the National Fire Protection Association (NFPA)

● Canada: Canadian Standards Association (CSA)
● Other countries:

– International Organization for Standardization (ISO)
– International Electrotechnical Commission (IEC)

 

3.2.3 Hazards by Improper Use
● High electrical voltage and high working current! Danger to life or serious

injury by electric shock!
● High electrical voltage by incorrect connection! Danger to life or injury by

electric shock!
● Dangerous movements! Danger to life, serious injury or property damage

by unintended motor movements!
● Health hazard for persons with heart pacemakers, metal implants and

hearing aids in proximity to electric drive systems!
● Risk of burns by hot housing surfaces!
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● Risk of injury by improper handling! Injury by crushing, shearing, cutting,
hitting!

● Risk of injury by improper handling of batteries!
● Risk of injury by improper handling of pressurized lines!
 

3.3 Instructions with Regard to Specific Dangers
3.3.1 Protection Against Contact with Electrical Parts and Housings

This section concerns components of the electric drive and control
system with voltages of more than 50 volts.

Contact with parts conducting voltages above 50 volts can cause personal
danger and electric shock. When operating components of the electric drive
and control system, it is unavoidable that some parts of these components
conduct dangerous voltage.
 
High electrical voltage! Danger to life, risk of injury by electric shock or serious
injury!
● Only qualified persons are allowed to operate, maintain and/or repair the

components of the electric drive and control system.
● Follow the general installation and safety regulations when working on

power installations.
● Before switching on, the equipment grounding conductor must have been

permanently connected to all electric components in accordance with the
connection diagram.

● Even for brief measurements or tests, operation is only allowed if the
equipment grounding conductor has been permanently connected to the
points of the components provided for this purpose.

● Before accessing electrical parts with voltage potentials higher than 50 V,
you must disconnect electric components from the mains or from the pow‐
er supply unit. Secure the electric component from reconnection.

● With electric components, observe the following aspects:
Always wait 30 minutes after switching off power to allow live capacitors
to discharge before accessing an electric component. Measure the elec‐
trical voltage of live parts before beginning to work to make sure that the
equipment is safe to touch.

● Install the covers and guards provided for this purpose before switching
on.

● Never touch electrical connection points of the components while power
is turned on.

● Do not remove or plug in connectors when the component has been pow‐
ered.

● Under specific conditions, electric drive systems can be operated at mains
protected by residual-current-operated circuit-breakers sensitive to uni‐
versal current (RCDs/RCMs).

● Secure built-in devices from penetrating foreign objects and water, as well
as from direct contact, by providing an external housing, for example a
control cabinet.
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High housing voltage and high leakage current! Danger to life, risk of injury by
electric shock!
● Before switching on and before commissioning, ground or connect the

components of the electric drive and control system to the equipment
grounding conductor at the grounding points.

● Connect the equipment grounding conductor of the components of the
electric drive and control system permanently to the main power supply at
all times. The leakage current is greater than 3.5 mA.

● Establish an equipment grounding connection with a copper wire of a
cross section of at least 10 mm2 (8 AWG) or additionally run a second
equipment grounding conductor of the same cross section as the original
equipment grounding conductor.

 

3.3.2 Protective Extra-Low Voltage as Protection Against Electric Shock 
Protective extra-low voltage is used to allow connecting devices with basic in‐
sulation to extra-low voltage circuits.
On components of an electric drive and control system provided by Bosch
Rexroth, all connections and terminals with voltages between 5 and 50 volts
are PELV ("Protective Extra-Low Voltage") systems. It is allowed to connect
devices equipped with basic insulation (such as programming devices, PCs,
notebooks, display units) to these connections.
 
Danger to life, risk of injury by electric shock! High electrical voltage by incorrect
connection!
If extra-low voltage circuits of devices containing voltages and circuits of more
than 50 volts (e.g., the mains connection) are connected to Bosch Rexroth
products, the connected extra-low voltage circuits must comply with the re‐
quirements for PELV ("Protective Extra-Low Voltage").
 

3.3.3 Protection Against Dangerous Movements
Dangerous movements can be caused by faulty control of connected motors.
Some common examples are:
● Improper or wrong wiring or cable connection
● Operator errors
● Wrong input of parameters before commissioning
● Malfunction of sensors and encoders
● Defective components
● Software or firmware errors
These errors can occur immediately after equipment is switched on or even
after an unspecified time of trouble-free operation.
The monitoring functions in the components of the electric drive and control
system will normally be sufficient to avoid malfunction in the connected drives.
Regarding personal safety, especially the danger of injury and/or property dam‐
age, this alone cannot be relied upon to ensure complete safety. Until the
integrated monitoring functions become effective, it must be assumed in any
case that faulty drive movements will occur. The extent of faulty drive move‐
ments depends upon the type of control and the state of operation.
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Dangerous movements! Danger to life, risk of injury, serious injury or property
damage!
A risk assessment must be prepared for the installation or machine, with its
specific conditions, in which the components of the electric drive and control
system are installed.
As a result of the risk assessment, the user must provide for monitoring func‐
tions and higher-level measures on the installation side for personal safety. The
safety regulations applicable to the installation or machine must be taken into
consideration. Unintended machine movements or other malfunctions are pos‐
sible if safety devices are disabled, bypassed or not activated.
To avoid accidents, injury and/or property damage:
● Keep free and clear of the machine’s range of motion and moving machine

parts. Prevent personnel from accidentally entering the machine’s range
of motion by using, for example:
– Safety fences
– Safety guards
– Protective coverings
– Light barriers

● Make sure the safety fences and protective coverings are strong enough
to resist maximum possible kinetic energy.

● Mount emergency stopping switches in the immediate reach of the oper‐
ator. Before commissioning, verify that the emergency stopping equip‐
ment works. Do not operate the machine if the emergency stopping switch
is not working.

● Prevent unintended start-up. Isolate the drive power connection by means
of OFF switches/OFF buttons or use a safe starting lockout.

● Make sure that the drives are brought to safe standstill before accessing
or entering the danger zone.

● Additionally secure vertical axes against falling or dropping after switching
off the motor power by, for example,
– mechanically securing the vertical axes,
– adding an external braking/arrester/clamping mechanism or
– ensuring sufficient counterbalancing of the vertical axes.

● The standard equipment motor holding brake or an external holding brake
controlled by the drive controller is not sufficient to guarantee personal
safety!

● Disconnect electrical power to the components of the electric drive and
control system using the master switch and secure them from reconnec‐
tion ("lock out") for:
– Maintenance and repair work
– Cleaning of equipment
– Long periods of discontinued equipment use

● Prevent the operation of high-frequency, remote control and radio equip‐
ment near components of the electric drive and control system and their
supply leads. If the use of these devices cannot be avoided, check the
machine or installation, at initial commissioning of the electric drive and
control system, for possible malfunctions when operating such high-fre‐
quency, remote control and radio equipment in its possible positions of
normal use. It might possibly be necessary to perform a special electro‐
magnetic compatibility (EMC) test.
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3.3.4 Protection Against Magnetic and Electromagnetic Fields During Oper‐
ation and Mounting

Magnetic and electromagnetic fields generated by current-carrying conductors
or permanent magnets of electric motors represent a serious danger to persons
with heart pacemakers, metal implants and hearing aids.
Health hazard for persons with heart pacemakers, metal implants and hearing
aids in proximity to electric components!
● Persons with heart pacemakers and metal implants are not allowed to

enter the following areas:
– Areas in which components of the electric drive and control systems

are mounted, commissioned and operated.
– Areas in which parts of motors with permanent magnets are stored,

repaired or mounted.
● If it is necessary for somebody with a heart pacemaker to enter such an

area, a doctor must be consulted prior to doing so. The noise immunity of
implanted heart pacemakers differs so greatly that no general rules can
be given.

● Those with metal implants or metal pieces, as well as with hearing aids,
must consult a doctor before they enter the areas described above.

 

3.3.5 Protection Against Contact With Hot Parts
Hot surfaces of components of the electric drive and control system. Risk of
burns!
● Do not touch hot surfaces of, for example, braking resistors, heat sinks,

supply units and drive controllers, motors, windings and laminated cores!
● According to the operating conditions, temperatures of the surfaces can

be higher than 60 °C (140 °F) during or after operation.
● Before touching motors after having switched them off, let them cool down

for a sufficient period of time. Cooling down can require up to 140 mi‐
nutes! The time required for cooling down is approximately five times the
thermal time constant specified in the technical data.

● After switching chokes, supply units and drive controllers off, wait 15 mi‐
nutes to allow them to cool down before touching them.

● Wear safety gloves or do not work at hot surfaces.
● For certain applications, and in accordance with the respective safety reg‐

ulations, the manufacturer of the machine or installation must take meas‐
ures to avoid injuries caused by burns in the final application. These
measures can be, for example: Warnings at the machine or installation,
guards (shieldings or barriers) or safety instructions in the application
documentation.

 

3.3.6 Protection During Handling and Mounting
Risk of injury by improper handling! Injury by crushing, shearing, cutting, hitting!
● Observe the relevant statutory regulations of accident prevention.
● Use suitable equipment for mounting and transport.
● Avoid jamming and crushing by appropriate measures.
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● Always use suitable tools. Use special tools if specified.
● Use lifting equipment and tools in the correct manner.
● Use suitable protective equipment (hard hat, safety goggles, safety shoes,

safety gloves, for example).
● Do not stand under hanging loads.
● Immediately clean up any spilled liquids from the floor due to the risk of

slipping.
 

3.3.7 Battery Safety
Batteries consist of active chemicals in a solid housing. Therefore, improper
handling can cause injury or property damage.
Risk of injury by improper handling!
● Do not attempt to reactivate low batteries by heating or other methods (risk

of explosion and cauterization).
● Do not attempt to recharge the batteries as this may cause leakage or

explosion.
● Do not throw batteries into open flames.
● Do not dismantle batteries.
● When replacing the battery/batteries, do not damage the electrical parts

installed in the devices.
● Only use the battery types specified for the product.

Environmental protection and disposal! The batteries contained in
the product are considered dangerous goods during land, air, and
sea transport (risk of explosion) in the sense of the legal regulations.
Dispose of used batteries separately from other waste. Observe the
national regulations of your country.

 

3.3.8 Protection Against Pressurized Systems
According to the information given in the Project Planning Manuals, motors and
components cooled with liquids and compressed air can be partially supplied
with externally fed, pressurized media, such as compressed air, hydraulics oil,
cooling liquids and cooling lubricants. Improper handling of the connected sup‐
ply systems, supply lines or connections can cause injuries or property damage.
Risk of injury by improper handling of pressurized lines!
● Do not attempt to disconnect, open or cut pressurized lines (risk of explo‐

sion).
● Observe the respective manufacturer's operating instructions.
● Before dismounting lines, relieve pressure and empty medium.
● Use suitable protective equipment (safety goggles, safety shoes, safety

gloves, for example).
● Immediately clean up any spilled liquids from the floor due to the risk of

slipping.
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Environmental protection and disposal! The agents (e.g., fluids)
used to operate the product might not be environmentally friendly.
Dispose of agents harmful to the environment separately from other
waste. Observe the national regulations of your country.

 

3.4 Explanation of Signal Words and the Safety Alert Symbol
The Safety Instructions in the available application documentation contain spe‐
cific signal words (DANGER, WARNING, CAUTION or NOTICE) and, where
required, a safety alert symbol (in accordance with ANSI Z535.6-2006).
The signal word is meant to draw the reader's attention to the safety instruction
and identifies the hazard severity.
The safety alert symbol (a triangle with an exclamation point), which precedes
the signal words DANGER, WARNING and CAUTION, is used to alert the
reader to personal injury hazards.

 DANGER

In case of non-compliance with this safety instruction, death or serious injury
will occur.

 WARNING

In case of non-compliance with this safety instruction, death or serious injury
could occur.

 CAUTION

In case of non-compliance with this safety instruction, minor or moderate injury
could occur.

 NOTICE
In case of non-compliance with this safety instruction, property damage could
occur.
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4 First Steps - CamBuilder
4.1 Preparation

Installation and Start The CamBuilder is integrated in the IndraWorks Suite installation package and
is thus automatically installed.
The CamBuilder starts automatically with IndraWorks Engineering if it is li‐
censed.

Licensing 1. A full license key has to be purchased in order to work unrestrictedly with
the CamBuilder.

2. The license overview opens via the Tools ▶ Options ▶ General ▶ Software
Licenses menu.

Fig.4-1: Menu: Tools

Fig.4-2: Dialog: Options (software licenses)

3. The CamBuilder license can be activated via the "License…" button.
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Fig.4-3: Dialog: Install Licenses
A demo license valid for 30 days is available without an activation key.
After 30 days, the objects managed by the CamBuilder are deactivated in
IndraWorks projects. The CamBuilder can be licensed to continue to use
the cams created. Otherwise, the deactivated objects can be deleted from
existing projects.

Library All CamBuilder objects can be found in the IndraWorks library under "Cam‐
Builder". These objects can be inserted via drag&drop (it is focused on individ‐
ual elements in the following examples).
The following objects are available:

Cam Pool All cams generated with the CamBuilder in the current project can be managed
in a "Cam Pool" folder.
A new cam can also be created via a "Cam Pool" node context menu.

Cam A cam in the CamBuilder is defined by one or several motion steps.
The cam can be opened for editing by double-click.

Preview A preview in the CamBuilder shows one or several cams with regard to a master
axis.
Open the preview with a double-click. Add more cams to the preview by
drag&drop.

4.2 Creating and Downloading Cams
This chapter explains, by means of an example, how to create and download
a cam consisting of 3 motion steps.

Task The master and slave axis are rotatory. The master axis rotates at a velocity of
100 rotations per minute.
The slave axis starts at 0 degrees and should be moved on a fixed axis range
of 180 degrees from standstill to 120 degrees. There it should pause for 100
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milliseconds (independent of the master axis velocity) and then up to the master
axis end position of 360 degrees return to 0 degrees at standstill.
The cam created is then downloaded to an MLC control.

Procedure 1. Creating the Cam

Fig.4-4: Menu: View
Via the menu "View", the "Project Explorer" and the "Library" are activated.

Fig.4-5: Library: CamBuilder section
A "Cam Pool" is added from the IndraWorks library in the "CamBuilder"
section with drag&drop.

Fig.4-6: Context menu: Cam Pool
In the Project Explorer, right click on the "Cam Pool" node and select the
New ▶ Cam... context menu item.
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2. Wizard

Fig.4-7: Dialog: Creating a new cam (Wizard)
Enter a specific name and optionally a description for the new cam in the
wizard. To create a freely-defined cam, select "none" under "Application-
specific Wizard".
The scalings of master and slave axis are set to "Rotatory (degree)."
To execute the cam cyclically, the option "Identical velocity in start and
end point" is selected.
The "Finish" button creates a default cam, saves it in the IndraWorks proj‐
ect and automatically opens a graph window.
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3. Edit Motion Step 1

Fig.4-8: Dialog: IndraWorks Engineering - First steps (cam)
The Motion Step Editor opens at the same time as the graph window. The
first motion step has been automatically generated and is entered with
default values. Depending on the motion law and mathematical degrees
of freedom, not all the motion fields can be edited. To facilitate entering
values, all editable fields are provided with a white background.
(a) The master axis rotates at 100 rpm.
(b) As all the steps have to be input in sequence, the editing mode shows
"Relative."
(c) The slave axis should follow the master axis, therefore the Reference
should be set to the motor symbol.
(d) The relative distance of the slave axis is defined as 120 degrees (ΔY).
(e) The distance is based on a master axis range of 180 degrees (ΔX).
(f) If the cam only consists of one step, the step type automatically has to
be defined as "Default step".
(g) The "rest-in-rest - Polynomial 5th order" is selected as the motion law.
All other fields are then automatically completed.
(h) Another step is added to the end of the focused step with the "Add
motion step after focused step" button.
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If focused, the graph view can be modified using the following keys:
● <Pos1> Show all
● <Arrow keys> Move view
● <+ / -> Zoom in view / Zoom out view
The zoom factor can be changed using the wheel of the mouse. The
view can be moved when the <space> key / or the mouse key in
the middle is pressed.
Special tool for changing the graph view are contained in the Cam‐
Builder tool bar.

Fig.4-9: CamBuilder Tool bar, graph
4. Edit Motion Step 2

Fig.4-10: Dialog: IndraWorks Engineering - First steps (cam)
The fields of the 2nd motion step are pre-assigned with standard values
from the CamBuilder options.
(a) The reference of the slave axis is changed from the master axis to the
time, deactivating the input fields ΔX and X3.
(b) Now the duration of the step in milliseconds has to be entered in column
ΔT (100 ms).
(c) Following the changeover of the motion law to "Rest-in-rest - Stand‐
still", all automatically calculated fields are deactivated.
After every input, the cam is automatically recalculated, and in doing so
rechecks whether all the values are feasible. Should values not be correct,
the relevant input field is marked and a message is displayed.
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By clicking on the first row of the table, it can be switched to the first motion
step. If the active step includes input errors, it is not possible to change to
another step. There is an option to undo the last changes to the cam using
the "Undo" button..
(d) Another step is added to the end of the focused step with the "Add
motion step after focused step" button.

5. Edit Motion Step 3

Fig.4-11: Dialog: IndraWorks Engineering - First steps (cam)
(a) The last step should relate to the master axis and, to this end, the slave
axis reference is set to the motor symbol.
(b) In order to relate the slave axis absolutely to the master axis, the step
type is set to "FlexStep with absolute distance and absolute master axis
range".
(c) The master axis end position X4 is set to 360 degrees.
(d) The slave axis end position Y4 is set to 0 degrees.
(e) The new cam is now displayed as a node below the "Cam Pool" node
in the Project Explorer.
(f) If the MLC in the project is online or is in offline-parameterization mode,
the cam can be downloaded to the control via its context menu in the
Project Explorer.
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6. Downloading the cam

Fig.4-12: Dialog: Download Cam to Device
The destination "FlexProfile 1" of "Axis 1" is selected. Confirming the di‐
alog with "OK" downloads the cam "first steps" into the parameters of the
control. A message confirms that the process has been successfully com‐
pleted.

Fig.4-13: Dialog: Download to Device

If there is already a FlexProfile on the axis and if the FlexProfile is
currently in use (axis in motion), the FlexProfile is write-protected
and cannot be replaced. Close the operation mode and write the
FlexProfile to another empty profile set.

4.3 Analyzing the Cam
This chapter describes the analysis of the cam from the previous chapter 4.2 
"Creating and Downloading Cams" on page 20.

Task The cam behavior of the master axis velocities is to be analyzed.
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Procedure 1. Creating preview
In the Project Explorer, right click on the "Cam Pool" node and select the
New ▶ Preview... context menu item.

2. Adding cams to the preview
The cam "First steps" can be moved to the preview window by keeping
the left mouse key pressed and dropping it.

Fig.4-14: Position preview of the cam at a master axis velocity of 100 rpm
3. Change master axis velocity

By clicking on "Settings...", the master axis velocity can be changed to e.g.
300 rpm.
As the 2nd cam motion step does not have a master axis range but it refers
to the time, there is less time for the 3rd motion step (FlexStep) to return
to the home position.
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Fig.4-15: Position preview of the cam at a master axis velocity of 300 rpm

The measuring line can be moved using the mouse.
The view of a preview window can be changed in the CamBuilder
tool bar via the graph tools.

4. Analyzing the slave axis velocity
By clicking on the blue position profile of the cam, the position preview of
the cam changes to a velocity preview. The velocity can be analyzed using
a measuring tool.
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Fig.4-16: Velocity preview of the cam at a master axis velocity of 300 rpm

Several cams can be added to a preview using drag&drop. The
cams can be analyzed simultaneously, referring to the same master
axis.
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5 Creating Cams and Preview Objects
5.1 Creating New Cams

Starting the wizard A new cam can be created in one step using the wizard.
The wizard is started via the context menu item New ▶ Cam... of the "Cam
Pool" node in the Project Explorer. An alternative is that a "cam" is copied from
the IndraWorks library from the "CamBuilder" section into the project.

General settings Multiple attributes of the cam are preset in the wizard.
The wizard suggests a default name ("Cam#") for the cam which can be
changed by the user.
The user can also enter a short description for the cam.
The application-specific wizard  determines whether a wizard should be used
for a specific application.
The CamBuilder provides wizards for common technologies (CrossCutter,
feed, print length correction, Flying Shear), which assist the user when creating
a cam. All the requirements and unique features of the application are dialog-
controlled.
No application-specific wizard is preset by default. The user can freely specify
the individual motion steps in the Motion Step Editor.
This property is set once when creating a cam and can no longer be changed
thereafter.
Additionally, the scalings of the master and slave axis can be set. These set‐
tings are automatically entered and deactivated when an Application-Specific
Wizard is selected.
Three standards can be selected for the scaling of an axis:
1. Rotatory (degree)

● Position = degree
● Velocity = rpm
● Acceleration = rad/s2

● Jerk = rad/s3

2. Translatory (mm)
● Position = mm
● Velocity = mm/min
● Acceleration = mm/s2

● Jerk = mm/s3

3. Translatory (inch)
● Position = inch
● Velocity = inch/min
● Acceleration = inch/s2

● Jerk = inch/s3

The selection of the units position, velocity, acceleration and jerk can be modi‐
fied individually. By the position unit, it is specified whether the axis is rotatory
or translatory. For the other variables, only the respective units can be selected.
1. Rotatory

● Position = degree; radiant
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● Velocity = rpm; rps; degrees/min; degrees/s; rad/min; rad/s
● Acceleration = rpm2; rps2; degree/min2; degree/s2; rad/min2; rad/s2

● Jerk = rpm3; rps3; degree/min3; degree/s3; rad/min3; rad/s3

2. Translatory
● Position = mm; inch
● Velocity = mm/min; mm/s; inch/min; inch/s
● Acceleration = mm/min2; mm/s2; inch/min2; inch/s2

● Jerk = mm/min3; mm/s3; inch/min3; inch/s3

Complete or cancel Once the entries are input, a cam is generated by the wizard after clicking on
"Finish".
Every cam can either be edited after "Completion" using the Motion Step Editor
or it can be edited via the graph.
The wizard can be closed at any time by using the "Cancel" function. All input
entries for the new cam are cancelled.

Application-specific cams can still be edited by the same wizard. If
an application parameter is changed and applied in the wizard win‐
dow, the complete cam is recalculated and any Motion Step Editor
or graph changes are overwritten.

To edit cams, see chapter 6  "Editing and Analyzing Cams" on page 33.

5.2 Creating Preview Objects
Creating preview A new, empty preview can be created via New ▶ Preview of the "Cam Pool"

node in the Project Explorer. An alternative is that a "preview" is copied from
the IndraWorks library from the "CamBuilder" section into the project.
The wizard suggests a unique name ("preview#") for the preview which can be
changed by the user.

Adding cams to the preview One or several cams can be taken from the current project via drag&drop and
added to a preview. Therefore, the desired cams are highlighted in the Project
Explorer, dragged with the left mouse button via the preview and dropped.

Removing cams from the preview A cam opened in preview can be removed from the preview via the "X" interface
of its title bar.
To analyze cams in the preview, see chapter 6.7  "Cam Preview" on page
55.
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6 Editing and Analyzing Cams
6.1 Graph Editor
6.1.1 General Information

The graph window is the core element in the CamBuilder. By opening a graph
(by double clicking on a cam via a "Cam Pool" node), the graph is displayed in
the IndraWorks main screen. Only one cam is always "focused" in the Cam‐
Builder and can be edited via the graph or the Motion Step Editor. If another
cam is opened, this cam is "focused." By focusing (clicking the cursor on a cam
window), the cam is automatically registered as focused by the CamBuilder. All
CamBuilder inputs and displays relate to the focused cam.

6.1.2 Design
A CamBuilder graph consists of a cam in a coordinate system.
In the coordinate system, up to 4 different profiles of the slave axis are displayed
at the same time (Position profile, Velocity profile, Acceleration profile and Jerk
profile).
The different profile diagrams can be shown and hidden using the Graph Man‐
ager (refer to chapter 6.1.5  "Graph Manager Settings" on page 35). The color
in which the profiles are displayed can be set using the Options dialog (see
chapter 10.1  "CamBuilder Options" on page 65).
The X-axis unit is the unit of the master axis.
The Y-axis unit corresponds to the respective focused profile diagram. A profile
diagram can be focused by clicking on the respective profile.
The axes of the coordinate system always have the color of the focused dia‐
gram; the grid helps to make the graph clearer.
The motion step limits are vertical lines which mark the limits of the motion
steps.
The focused motion step is highlighted by a different background color.
Another step can be focused by clicking in the area of this motion step.
The limit points of a focused motion step  are highlighted by a black dot.
The section of the cam displayed in the coordinate system can be zoomed in
and out or offset.

6.1.3 Editing a cam graphically
Moving the starting or end point The starting and end points of the focused profile (position, velocity, accelera‐

tion or jerk) of the focused motion step are shown as black dots.
If a point can be moved, this is shown as a symbol with arrows when the cursor
hovers over the point.

 Data point can be moved horizontally and vertically

 Data point can only be moved horizontally

Data point can only be moved vertically
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The data points of the Position diagram can be moved vertically and horizon‐
tally, depending on the editability of the values defined by the selected motion
law.
The cam changes in different ways depending on the editing mode (relative or
absolute) which has been set. The behavior of the cam, when the limit values
are changed, is described in more detail in chapter 6.2.9  "Absolute Editing of
the Master Axis Range (X-values)" on page 44 and chapter 6.2.10  "Relative
Editing of the Master Axis Range (X-values)" on page 45.
The data points of the Velocity, Acceleration and Jerk diagrams can only be
offset vertically, in line with the editability of the values defined by the selected
motion law.

Deleting a focused motion step A motion step is deleted using the graph context menu in the same way as is
described in chapter 6.2.14  "Deleting a Focused Motion Step" on page 49.

6.1.4 Changing the View
Via the tool bar, a graph can be set to different modes. By default, a selection
tool (arrow) is activated.

Fig.6-1: Icons: Tools for the CamBuilder graph window
Show All The entire cam can be represented using the context menu item Show All .

Alternatively, this function is triggered via the "tool bar", the "Graph Manager"
and the <Pos1> key.

Selection The context menu item Selection enables an arrow as mouse cursor. Points
can be moved and profiles can be activated in this mode.
Alternatively, this function is activated via the "tool bar", the "Graph Manager"
and the <ESC> key.

Zoom In The context menu item Zoom In enables a magnifying glass as mouse cursor.
By clicking in the coordinate system and marking a rectangle, the area to be
zoomed can be specified.
An alternative is that this mode is activated via the "tool bar" and the "Graph
Manager".
The mouse wheel also controls the zoom level.
The keys <+>/<-> zoom the view in/out by 25%.

Pan View The context menu item Pan enables a hand icon as mouse cursor. By clicking
in the coordinate system and dragging, the section can be panned.
An alternative is that this mode is activated via the "tool bar" and the "Graph
Manager".
The graph can also be panned using the mouse key in the middle or using the
<space> key.

Copy Graph to Clipboard The section of the cam currently being displayed can be copied to the clipboard
via the context menu and used in other applications, such as word processing.

Show Tool Window The main graph window context menu has a menu to activate all other Cam‐
Builder Tools windows.
The option to show/hide all tool windows created by the CamBuilder is offered
in the View ▶ Other Windows IndraWorks menu.

Restore default layout The menu Restore Default Layout hides all CamBuilder tools, with the excep‐
tion of the Motion Step Editor and the Graph Manager and activates the Toolbar.
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All windows can be arranged at will and shown or hidden by the user. Each
layout change is permanently saved. The last used layout is preset during a
CamBuilder restart.

6.1.5 Graph Manager Settings
The Graph Manager can be opened via the context menu of a graph or a pre‐
view: Tool window ▶ Graph Manager. Via the main menu, View ▶ Other
Windows ▶ Graph Manager can be shown or hidden.
The Graph Manager is used to focus, show and hide the different profile dia‐
grams.
● Slave axis position (shown/hidden and focused/not focused)
● Velocity (shown/hidden and focused/not focused)
● Acceleration (shown/hidden and focused/not focused)
● Jerk (shown/hidden and focused/not focused)
Different actions can be started via the "Graph tool selection" buttons for the
graph window
● Show All
● Selection
● Zoom In
● Pan
The cursor coordinates in relation to the focused profile diagram of all units are
shown in the cursor coordinates area.
Via the advanced options, the visibility of different data can be set in the Graph
window.
● Coordinate axes (Shown/Hidden)
● Coordinate grid (Shown/Hidden)
● Motion step limits (Shown/Hidden)
● Border Coordinates (Shown/Hidden)
The settings in the Graph Manager have a direct effect on the graphic output.

Project-comprehensive settings such as colors and line width can
be set for the graph and preview windows in the main menu
Tools ▶ Options ▶ CamBuilder ▶ Graph (see chapter 10.1  "Cam‐
Builder Options" on page 65).

6.2 Motion Step Editor
6.2.1 Overview

A cam can consists of any number of motion steps. The Motion Step Editor
serves to configure the individual motion steps.

The MotionProfile and FlexProfile operation modes of the devices
are limited to a maximum number of motion steps! If too many steps
are defined, the cam can no longer be downloaded for the corre‐
sponding operation mode.
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Fig.6-2: Dialog box: Motion Step Editor - CamBuilder
The Editor is divided into three areas.

1. The higher-level part (a) relates to all of the cam motion steps.
2. The tabular part (b) provides, on the one hand, an overview and navigation

between the individual motion steps and, on the other hand, allows
changes to be made to the single attributes.

3. The form-based section (c) provides the option of editing other attributes
of the motion step focused in the tabular part.

A motion step is set as default.
Not all attributes can always be edited. Some attributes are automatically cal‐
culated depending on the choice of other attributes. All deactivated attributes
are always calculated after a property has been changed (after clicking on the
<Enter> key or by changing the cursor to another attribute.) If a non-numerical
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value is entered into a numerical entry field, the value is automatically rejected.
Other incorrect entry fields are marked by an error symbol and a message ap‐
pears.
The previous 50 changes to a cam can be undone providing the cam has not
been saved.

6.2.2 High-Level Attributes
The high-level attributes relate to the entire cam.

Master axis velocity A cam is defined with reference to a master axis velocity. All limit values of the
motion steps refer to this master axis velocity in the editor.
A "preview" can be created (see chapter 5.2  "Creating Preview Objects" on
page 32) in order to analyze the cam behavior during different master axis ve‐
locities.
The master axis velocity is set depending on the preset master axis scaling.
This attribute can always be edited.
Minimum
● Master axis velocity > 0
● The master axis velocity has to be high enough that no ΔX of a time-related

motion step is lower than the minimum step size (see chapter 10.1  "Cam‐
Builder Options" on page 65).

Maximum
● The master axis velocity has an upper limit, in case there are time-related

motion steps in front of a FlexStep with an absolute master axis end po‐
sition and these would extend beyond the absolute master axis end
position.

Editing mode The "Relative" or "Absolute" editing mode determines the behavior of the sub‐
sequent motion steps when ΔY, ΔX, ΔT, Y1 or X2 are edited (see also chapter
6.2.9  "Absolute Editing of the Master Axis Range (X-values)" on page 44 and
chapter 6.2.10  "Relative Editing of the Master Axis Range (X-values)" on page
45).

6.2.3 Attributes of the Tabular Section
The attributes of the tabular section show the values of all cam motion steps.
Only the values of the focused motion step can be edited.

Reference The reference defines to what the slave axis should orient itself to. There are
two options:
● The motion of the slave axis should follow the master axis; this option is

displayed by a motor symbol (default).
● The motion of the slave axis should follow the time; this option is displayed

by a clock symbol.
This attribute can always be edited.

ΔY ΔY represents the relative distance of the slave axis within the focused motion
step and is given as a unit of the slave axis.
Changing delta Y immediately results in a calculation of Y2 .
This attribute cannot be edited if the step type is a "FlexStep with an absolute
slave axis position" or if the current motion law defines the distance.

ΔX Δ X represents the relative master axis range of the focused motion step in
relation to the master axis and is given as a unit of the master axis.
Changing ΔX immediately results in the calculation of X2  and ΔT.
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This attribute cannot be edited if the reference of the slave axis is time (the
value is then calculated by the master axis velocity and ΔT.)
This attribute cannot be edited if the step type is a "FlexStep with an absolute
master axis position" or if the current motion law defines the master axis range.
Minimum
● ΔX >= minimum step size
Maximum
● ΔX has an upper limit if a FlexStep with an absolute master axis end po‐

sition follows and ΔX would extend the focused step beyond the absolute
master axis end position.

ΔT ΔT represents the relative duration of the focused motion step measured in
milliseconds.
Changing ΔT immediately results in the calculation ΔX and X2 .
This attribute cannot be edited if the reference of the slave axis is the master
axis position (the value is then calculated by the master axis velocity and ΔX.)
This attribute cannot be edited if the step type is a "FlexStep with an absolute
master axis position" or if the current motion law defines the master axis range.
Minimum
● ΔT >= 1 millisecond
Maximum
● ΔT has an upper limit if a FlexStep with an absolute master axis end po‐

sition follows and ΔT would extend the focused step beyond the absolute
master axis end position.

6.2.4 Attributes of the Form-Based Section
The attributes of the form-based section relate to the focused motion step.

Step type There are 2 categories of step type.
● Default step

A default step has limit values defined when it is created (X1, Y1, V1, A1,
J1, X2, Y2, V2, A2, J2). The motion path is calculated on the basis of these
values The motion path of a default step is thus rigid and does not change
in operation.
Any motion law can be used for this step type.

● FlexStep
A FlexStep is an active step, that it to say it carries over the starting point
limit values in operation from the real values (X1, Y1, V1, A1, J1) and the
limit values of the end point from the pre-defined values (ΔX or X2, ΔY or
Y2, V2, A2, J2). The motion path is calculated in operation so that there are
no steps in velocity.
There are four different types of FlexStep
– FlexStep with relative distance and relative master axis range

ΔX and ΔY are user-defined
X2 is calculated from X1 + ΔX
Y2 is calculated from Y1 + ΔY

– FlexStep with absolute slave axis end position and relative master
axis range
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Y2 and ΔX are user-defined
ΔY is calculated from Y2 - Y1

X2 is calculated from X1 + ΔX
– FlexStep with relative distance and absolute master axis end position

This step type cannot be selected for time-dependant motion steps.
X2 and ΔX are user-defined
ΔX is calculated from X2 – X1

Y2 is calculated from Y1 + ΔY
– FlexStep with absolute slave axis end position and absolute master

axis end position
This step type cannot be selected for time-dependant motion steps.
Y2 and X2 are user-defined
ΔX is calculated from X2 – X1

ΔY is calculated from Y2 - Y1

Only motion laws of the "General motion type" (Polynomial 5th order or
Polynomial 7th order) can be used for a FlexStep.
If a FlexStep is selected, and the current motion law does not fit, then there
is an automatic changeover to a polynomial 5th order.
The step type attribute can be edited if the subsequent step is a default
step. If the last step is focused and the starting velocity and the starting
acceleration are identical to the end velocity and the end acceleration of
the cam (cyclical design of cam), then the first step of the cam is adopted
as the subsequent step.

Motion Law The motion law defines the motion of the slave axis, performed between the
starting and end points of the focused motion step.
The different motion laws are described in detail in chapter 12  "Motion Laws"
on page 69.
The motion law is selected using the following dialog:
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Fig.6-3: Dialog box: Motion law selection
The dialog is sub-divided into two sections:
At the top is a filter option, which is used to display only specific motion laws,
e.g. only for MotionProfile.
The lower sections displays the motion laws.
Existing cam tables for the focused cam can be uploaded as a motion law under
the category "Cam Table". Only the cam tables used as the motion law with the
cam are stored. Imported cam tables, which are not used, are no longer ac‐
cessible once the cam has been closed and reopened.
Not all motion laws can always be selected. If the preceding step ends in rest,
the focused motion step has to be continued with rest or a general motion law.
If the step type is not a default step, then only two motion laws of the general
motion type (polynomial 5th order and 7th order) are available.

Starting point X1 X1 is the master axis position at the starting point of the focused motion step in
the master axis unit.
Minimum
● X1 >= 0
Maximum
● X1 has an upper limit if a FlexStep with an absolute master axis end po‐

sition follows and X1 would extend the focused step beyond the absolute
master axis end position.

Y1 X1 is the slave axis position at the starting point of the focused motion step in
the slave axis unit.
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This attribute cannot be edited if Y2 of the preceding step cannot be edited.

Y1, the offset of the first motion step, serves only for the purpose of
illustration in the CamBuilder and is deducted when carried over
into the devices.

V1 V1 is the velocity at the starting point of the focused motion step. The unit is
dependent on the slave axis scaling selected.
This attribute cannot be edited if it is automatically calculated by the selected
motion law or if V2 of the preceding step cannot be edited.

A1 A1 is the acceleration at the starting point of the focused motion step. The unit
is dependent on the slave axis scaling selected.
This attribute cannot be edited if it is automatically calculated by the selected
motion law or if A2 of the preceding step cannot be edited.

J1 A1 is the jerk at the starting point of the focused motion step. The unit is de‐
pendent on the slave axis scaling selected.
This attribute cannot be edited if it is automatically calculated by the selected
motion law or if J2 of the preceding step cannot be edited.

End point X2 X2 is the master axis position at the end point of the focused motion step in the
master axis unit.
Should there be a motion step in the cam which includes an absolute master
axis end position as its step type, then the X2 change of the other motion steps
is limited by this point.
The following applies if the focused motion step lies before the step with an
absolute master axis end position:
(X1 focus + minimum step size <= X2 focus <= X2 fix + minimum step size)
This attribute X2 cannot be edited if the reference of the slave axis is the time
(the value is then calculated by the master axis velocity and ΔT.)
The attribute X2 cannot be edited if the step type is a FlexStep with a relative
master axis range or if the motion law is an Extended motion law with acceler‐
ation-limited motion trapezium profile or with acceleration-limited motion sinus‐
oid profile or with jerk-limited motion.
Minimum
● X2 >= X1 + minimum step size
Maximum
● X2 has an upper limit if a FlexStep with an absolute master axis end po‐

sition follows and X2 would extend the focused step beyond the absolute
master axis end position.

Y2 Y2 is the slave axis position at the end point of the focused motion step in the
slave axis unit.
This attribute cannot be edited if it is automatically calculated by the selected
motion law or if Y1 of the preceding step cannot be edited.

V2 V2 is the velocity at the end point of the focused motion step. The unit is de‐
pendent on the slave axis scaling selected.
This attribute cannot be edited if it is automatically calculated by the selected
motion law or if Y1 of the preceding step cannot be edited.
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A2 A2 is the acceleration at the end point of the focused motion step. The unit is
dependent on the slave axis scaling selected.
This attribute cannot be edited if it is automatically calculated by the selected
motion law or if Y1 of the preceding step cannot be edited.

J2 J2 is the jerk at the end point of the focused motion step. The unit is dependent
on the slave axis scaling selected.
This attribute cannot be edited if it is automatically calculated by the selected
motion law or if Y1 of the preceding step cannot be edited.

Maximum values Vmax Vmax is the maximum velocity of the focused motion step. The unit is dependent
on the slave axis scaling selected.
This attribute cannot be edited if it is automatically calculated by the motion law
selected in the focused motion step.

Amax Amax is the maximum acceleration of the focused motion step. The unit is de‐
pendent on the slave axis scaling selected.
This attribute cannot be edited if it is automatically calculated by the motion law
selected in the focused motion step.

Jmax Jmax is the maximum jerk of the focused motion step. The unit is dependent on
the slave axis scaling selected.
This attribute cannot be edited if it is automatically calculated by the motion law
selected in the focused motion step.

Cmdyn The dynamic torque characteristic value Cmdyn is calculated on the basis of the
following equation:
Cmdyn= Maximum value (V * A)
The unit is dependent on the slave axis scaling selected.
This attribute can never be edited and is always automatically calculated.

Turning point displacement The turning point displacement stipulates at which point the curving behavior
changes for a symmetrical motion law.
The turning point displacement can either be changed with the slider or by in‐
putting a percentage value between 0 and 1.
This attribute can be edited for all symmetrical "Rest-in-rest" motion laws.

Description The description includes brief user-defined information about the focused mo‐
tion step.
This attribute can always be edited.

6.2.5 Calculating Motion Steps
The cam is recalculated following every input (changing to another input field
or confirming by means of the <Enter> key). Should the calculation not be pos‐
sible, the incorrect input fields are highlighted and clear explanatory information
is provided. The motion step is only applied if all inputs are correct.
The "Undo motion step" function allows all changes that have been made since
the motion step was successfully calculated the last time to be undone.
If an action is to be performed, which requires the focused motion step in a
calculated format, e.g. another motion step is highlighted in the table as an
active motion step or a new motion step is to be inserted, then the active motion
step has to be error-free.
If there are still incorrect entries, then the last focused motion step remains
active until all the inputs are correct or have been undone.
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6.2.6 Undo / Redo Editing
Via the menu item Edit ▶ Undo the last 50 times a focused cam has been edited
since the last saving action can be reset.
Once editing has been undone, it can still be redone providing no further change
has been made to the cam.

6.2.7 Absolute Editing of the Slave Axis Position (Y Values)
If the Y-value or ΔY in a motion step is changed in the "Absolute edit mode",
then only this individual value is changed and the rest of the position profile
remains at the original position.
IMPORTANT: If the change to a motion step results in the limit values of the
subsequent step no longer fitting its motion law, then the distance of the sub‐
sequent step is regarded as a fixed value and the motion law is possibly set to
a Polynomial 5th order.
In the following example, the distance of the 3rd motion step cannot be edited
that is why the distance of the 4th motion step is adjusted.
Example:

Absolute editing of ΔY

Fig.6-4: Absolute edit mode

Fig.6-5: Changing ΔY in the second motion step by -50 degrees
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6.2.8 Relative Editing of the Slave Axis Position (Y Values)
If the Y-value or ΔY in a motion step is changed in the "Relative edit mode",
then the remainder of the position profile is displaced in the Y-direction by the
value of the change.
IMPORTANT: If the change to a motion step results in the limit values of the
subsequent step no longer fitting its motion law, then the distance of the sub‐
sequent step is regarded as a fixed value and the motion law is possibly set to
a Polynomial 5th order.
Example:

Relative editing of ΔY

Fig.6-6: Relative edit mode

Fig.6-7: Changing ΔY in the second motion step by -50 degrees

6.2.9 Absolute Editing of the Master Axis Range (X-values)
With changes to the master axis range (ΔX, ΔT, X1 or X2) of individual motion
steps in the "Absolute edit mode", the total length of the cam remains. This
means that the change to the length of an individual motion step changes the
length of the preceding or subsequent motion step.
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This mode is recommended if, for example, a cam with a fixed length of 360
degrees is to be edited and a motion step in the cam has to be shortened or
extended, but the total length of the cam has to be retained.
If, in the "Absolute edit mode", a (new) motion step extends in the X-direction
beyond one or more subsequent steps, then these steps are overwritten.
Example:

Absolute editing of ΔX or Xn

Fig.6-8: Absolute edit mode

Fig.6-9: Changing ΔX in the second motion step by +40 degrees

6.2.10 Relative Editing of the Master Axis Range (X-values)
The total length of the cam changes with a change to the master axis range
(ΔX, ΔT, X1 or X2) of individual motion steps in the "Relative edit mode". The
ΔX or ΔT values of the preceding and subsequent motion steps are not
changed.
This mode is recommended if, for example, a cam is being created for the first
time or if time-dependent motion steps have to be identified. If, for example, the
duration of a motion step is shortened, then the duration of the total cam has
to be shortened.
Example:

Relative editing of ΔX or Xn

Fig.6-10: Relative edit mode
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Fig.6-11: Changing ΔX in the second motion step by +40 degrees

6.2.11 Editing the Motion Step Cam Table
If the focused motion step includes a cam table as a motion law, then, in addition
to selecting the motion law, a modal window can be opened via an interface for
editing the cam table.

Fig.6-12: Icon: Edit cam table
All % values of the cam table can be edited in this window.
Points can be deleted. In this case, the X-values are recalculated and the ex‐
isting Y-values retain their values. At least 3 points have to remain.
New points will be added after the focused line, the X-values are recalculated
and the existing Y-values retain their value. At least 3 and at most 1024 points
can be inputted.
The X-values are always given as a unit of the master axis and the Y-values
are recorded as a percentage value. In the cam table, the first X-value always
corresponds to the first master axis position of the motion step and the last X-
value corresponds to the last master axis position of the motion step.

6.2.12 Adding a New Step after the Focused Step
This function adds a new motion step at the end of the focused motion step and
gives ΔX the default step size from the options and the motion law "General
motion - Polynomial 5th order".
The limit values of the starting point of the new motion step are carried over
from the focused end point.
If the "Relative edit mode" is active, then the total length of the cam increases.
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The limit values of the end point are, if available, applied by the starting point
of the subsequent motion step. If there is no subsequent motion step, then the
limit values are given the values "0".
If the "Absolute edit mode" is active, then the total length of the cam is retained.
The limit values of the end point are given the values of the previous subsequent
step at its point (X1 + default step size) and the subsequent step is shortened
by the default step size. Should this not be possible, a clear and understandable
message appears explaining why a step cannot be inserted at this position. If
there is no subsequent motion step, then the limit values are given the values
"0".
The new inserted motion step is activated following the insertion.
Example:

Fig.6-13: Absolute edit mode

Fig.6-14: A new step is added at the end of the 2nd motion step.

Example:

Fig.6-15: Relative edit mode

DOK-IWORKS-CAMBUIL*V10-FK02-EN-P 
Rexroth IndraWorks  10VRS CamBuilder 

Bosch Rexroth AG 47/103

Editing and Analyzing Cams



Fig.6-16: A new step is added at the end of the 2nd motion step.

6.2.13 Adding a New Step before the Focused Step
The "Add before" function adds a new motion step before the focused motion
step and gives ΔX the default step size and gives the motion law the Polynomial
5th order.
The limit values of the starting point of the new motion step are carried over
from the end point of the preceding step.
If the "Relative edit mode" is active, then the total length of the cam increases.
All subsequent steps are displaced backwards by ΔX.
If the "Absolute edit mode" is active, then the total length of the cam is retained.
The limit values of the end point are given the values of the previous step fo‐
cused at its point (X1 + default step size) and the previous step is shortened by
the default step size. Should this not be possible, a clear and understandable
message appears explaining why a step cannot be inserted at this position.
The new inserted step is activated following the insertion.
Example:

Fig.6-17: Absolute edit mode
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Fig.6-18: A new step is added at the end of the 2nd motion step

Example:

Fig.6-19: Relative edit mode

Fig.6-20: A new step is added at the start of the 2nd motion step

6.2.14 Deleting a Focused Motion Step
A cam requires at least one motion step. If a cam consists of more than one
motion step, then the focused motion step can be deleted.
If the "Relative edit mode" is active, then the total length of the cam is shortened.
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If the "Absolute edit mode" is active, then the total length of the cam is retained.
The total length is retained by the subsequent motion step (if there is not one,
then the preceding) being extended by ΔX of the step to be deleted. Should this
not be possible, then the motion step cannot be deleted.
Example:

Fig.6-21: Absolute edit mode

Fig.6-22: Deleting motion step 2

Example:

Fig.6-23: Relative edit mode
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Fig.6-24: Deleting motion step 2

6.3 Event Editor
6.3.1 Overview

The event editor is used to define events.
The MLC FlexProfile supports the event control. Events can be assigned to
motion steps. Events consist of a trigger and an action. Bits of the AxisData
structure can be set during the execution time of the FlexProfile via the action
of an event. The PLC offers solutions to react to these events.
An event can be added to a focused motion step via the tool bar in the Cam‐
Builder.

Fig.6-25: Icon: Add event

6.3.2 Attributes
Events can be added to each motion step of a cam. One condition consists of
a trigger and an action.

No. The number is assigned automatically and serves to identify the event.
Motion Step Each event is assigned to a certain motion step (Selection possibility: All motion

steps of the focused cam).
Trigger The trigger is the criteria when the event is triggered:

● Absolute master axis position reached
The event is triggered when the master axis position entered in the as‐
signed motion step is reached.
Similar to a programmable limit switch, the current position of an axis can
be monitored. If it crosses a specified position in the current motion step,
the event occurs.
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● Relative master axis path traveled
The event is triggered when the master axis position entered in the as‐
signed motion step is reached.

● Absolute slave axis position reached
The event is triggered when the master axis position entered in the as‐
signed motion step is reached.

● Relative slave axis path traveled
The event is triggered when the master axis position entered in the as‐
signed motion step is reached.

● PLC signal
The event is triggered if the PLC signal is set during execution of the as‐
signed motion step.

● Time lapsed
The event is triggered when the time specified as value has lapsed during
the execution of the assigned motion step.

Value The value is dependent on the trigger (position, travel distance or time).
Unit The unit is displayed depending on the selected trigger (position and travel

distance, specified in the unit of the master or slave axis, time in s).
Bit If the trigger criteria is fulfilled during the execution of the assigned motion step,

the selected bit from the AxisData structure is set. (Selection possibilities: Bit0
to Bit15).

Action The action defines when the bit should be set:
● At the end of the profile

The selected bit is set after execution of the last motion step at the end of
the profile.

● At the end of the motion step
The selected bit is set after executing the selected motion step.

● Set immediately
The selected bit is set immediately.

● Set immediately and connect next motion step immediately
The selected bit is set immediately and the next motion step is executed.
If the next motion is a FlexStep, the limit values can be applied dynamically
during runtime and the transition can be started without jerks.

If one or more events are assigned to a motion step, they are dis‐
played in the Graph editor in the lower right area as active lighting
symbol. The event editor opens by clicking on the symbol.
If a cam with events is displayed in a preview, it is displayed at which
time which bit is activated.

6.3.3 Functions
Create New Event A standard event is inserted at the end of the event list. (Motion Step: Focused

step; trigger: PLC signal; bit: Bit0; action: set immediately).
Editing Events can be edited in this list.

Remove event The event focused in the list is removed.
Undo Undoes the most recent change.

Restore If a change has been undone, this function restores it again.
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Help Opens the Event Editor chapter of the CamBuilder online help.

By downloading a cam, the events are written in the corresponding
parameter.
If a cam contains events, they are generated using the PLC function
block for the FlexProfile generation.
If a motion step number changes, as e.g. an additional step is in‐
serted, events remain assigned to the originally assigned motion
step. If a motion step is removed, the events belonging to the motion
step are also removed.

6.4 Application-Specific Wizard
6.4.1 General

An application-specific cam has, depending on its type of application, a special
wizard with which the entire cam can be edited.
Single motion steps can be reedited later at any time using the Motion Step
Editor (see chapter 6.2  "Motion Step Editor" on page 35). However, as soon
as a change has been performed using the wizard, all Motion Step Editor
changes are overwritten.

6.4.2 CrossCutter Wizard
The CamBuilder provides a wizard for common requirements, such as the
CrossCutter functionality, which supports the user in creating the cam. All the
requirements and unique features of the application are dialog-controlled.
The specific inputs for the CrossCutter functionality are:
● Length format
● Roller diameter
● Cutting angle
● Velocity of the master axis

6.4.3 Feeder Wizard
The CamBuilder provides a wizard for common requirements, such as the feed
function, which supports the user in creating the cam. All the requirements and
peculiarities of the application are set using dialog-controlled inputs.
The specific inputs for the feed function are as follows:
● Length format
● Roller diameter
● Maximum delay
● Acceleration path
● Roller position
● Distance between two products
● Velocity of the master axis
To achieve the feed configured in the CamBuilder, the distance factor during
the download as points table has to be set equal to the distance factor during
the execution in the application.
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6.4.4 Print Length Correction Wizard
The CamBuilder provides a wizard for common requirements, such as the print
length correction, which supports the user in creating the cam. All the require‐
ments and unique features of the application are dialog-controlled.
The specific inputs for the print length correction are as follows:
● Diameter of the pressurized cylinder
● Length of the printing plate
● Correction value
● Velocity of the master axis
A further parameter is calculated by the wizard:
● Gradient in the synchronous range

6.4.5 Flying Shear Wizard
The CamBuilder provides a wizard for common requirements, such as the Fly‐
ing Shear, which supports the user in creating the cam. All the requirements
and unique features of the application are dialog-controlled.
Specific entries for the Flying Shear:
● Synchronous range - range within which the cut is executed
● The motion law in the transition area - Modified sine curve, Polynomial 3rd

order, Polynomial 5th order and Polynomial 7th order motion laws are
available.

Another parameter is calculated by the wizard:
● Gradient in the synchronous range

6.5 Cam Table
The cam table is an overview of the complete travel of the cam.
The user can determine the number of data points for the entire position profile.
It is also possible to define with which distance the percentage values are to be
calculated.
The distribution of the points across the master axis range can be specified
using the following option:
The last data points in the table belongs to X: 100% (Yes/No) (table format).
Assuming the number of data points is 1024:

Yes: 100% is divided exactly between 1024 points

 0,0000% = Point 1

 99,9023% = Point 1023

 100,0000% = Point 1024

No: The 100% is divided between 1024 + 1 points

 0,0000% = Point 1

 99,9024% = Point 1024

 100,0000% = Point 1

Fig.6-26: The units in the gaps are dependent on the master and slave axis units
The table is write-protected and has the following columns:
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Number, Y [%], Master axis position, Slave axis position, Velocity, Acceleration,
Jerk. The values refer to the master axis velocity defined in the motion step
editor.
The values of the table can be copied to the clipboard and the values can be
taken from there and, via "Insert", can be used in other programs.

6.6 Extreme Values
The minimum and maximum values referred to the master axis velocity defined
in the motion step editor for the entire cam are displayed in the extreme values
list.
Extreme values list

Profile diagram Minimum Maximum Unit

Slave axis position    

Velocity    

Acceleration    

Jerk    

Dyn. torque char.
value    

Fig.6-27: Creating the extreme values list
The dynamic torque characteristic value is calculated on the basis of the fol‐
lowing equation:
Cmdyn = Maximum value (Vmax * Amax)
where Vmax = maximum velocity and Amax = maximum acceleration.

This window can be shown or hidden via the menu item
View ▶ Other Windows ▶ Extreme Values - CamBuilder .

6.7 Cam Preview
Cams are graphically edited in the "Graph Editor" (see chapter 6.1  "Graph
Editor" on page 33).
In order to compare several cams with regard to a master axis, the cams can
be opened in a preview and analyzed there.
A new preview is added to the project via a "Cam Pool" or the IndraWorks library
(see chapter 5.2  "Creating Preview Objects" on page 32).

Depending on the selected operating mode in the application, dif‐
ferences to the preview can occur in reality. Cams and MotionPro‐
files do not support time-dependent steps or events.
Master and slave axis offsets have to be specified in the user pro‐
gram via the corresponding function blocks when activating the
respective synchronization mode. (e.g. MB_PhasingSlave,
MB_Phasing in all operating modes or via the corresponding inputs
at the ML_FlexProfile function block)

Preview window design A preview window consists of the time-dependent position representation of a
master axis and the optional time-dependent profile representations (position /
velocity / acceleration / jerk) of the slave axes.
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The individual positions in the preview window can be moved upwards or
downwards via a system menu in the upper right corner of the respective pre‐
view. The previews can be distributed in the preview window and individual
previews can also be closed.

The height of the individual previews can be changed using the
mouse. The line between two previews is "held" using the mouse
and the size is adjusted by moving the mouse.
If the <Ctrl>key is pressed when changing the size, the entire size
of the preview can be adjusted.

Measuring Function The measuring line can be moved in the selection mode (arrow) using the
mouse. The measuring results are shown in the title bar of each preview. In
order to measure another profile (position / velocity / acceleration / jerk), it can
be selected using the mouse. The measuring results refer to this profile.

Change of view The view can be changed using the same tools as the Graph Editor (see chapter
6.1.4  "Changing the View" on page 34).
The individual views of the previews are synchronized on the X axis. The same
time section is always displayed.

Master axis properties The following attribute of the master axis representation can be changed via
the link "Settings...":
● Master axis velocity

The unit of the master axis velocity depends on the scaling.
● Preview of time

The unit of the preview time is milliseconds.
● Modulo

Defines the overflow for the graphic representation.
● Scaling

(rotatory or translatory and unit).
Slave axes properties The following attributes of the slave axis representation can be changed via the

link "Settings..." of the slave axis:
● Modulo

Defines the overflow for the graphic representation.
● Master axis offset

Defines the offset in the master axis range.
● Slave axis offset

Defines the offset in the slave axis range.
● Execution mode

Cyclical
Cyclical with defined pause
One-time

The cyclic representation with a defined pause is used to preview cams started
with the processing type "One-time execution" by cyclic events (e.g. of other
cams) .
The master axis offset can either be entered in the master axis unit or in ms.
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7 Managing Cams and Preview Objects in the
IndraWorks Project

General Information Cams and preview objects are managed by the CamBuilder within the
IndraWorks project and are also archived and restored using this project. They
are managed in the Project Explorer below the "Cam Pool" node.
A cam can also be exported if it is to be used outside the project.
It is also possible to import existing cams into a project (refer to chapter 9 
"Importing and Exporting Cams" on page 63).
Cams can also be used within the project if one or more devices are online or
are in offline parameterization mode, can be downloaded to these or can be
uploaded from these to the project (refer to chapter 8  "Interacting with Bosch
Rexroth Devices" on page 59).

"Cam Pool" Create folder A "Cam Pool" folder can be copied from the IndraWorks library from the "Cam‐
Builder" section into the project using drag&drop.
Via the context menu of a "Cam Pool" node in the project explorer, a new folder
can be created below this one. Cams and preview objects can also be created
and edited within this folder. This folder can be renamed or deleted via the
context menu.
A "Cam Pool" folder can be moved within the project. Several "Cam Pool" fold‐
ers can exist in one project.

Opening a cam / preview A cam and a preview is opened by double-clicking on the relevant symbol in
the "Cam Pool" node in the Project Explorer. The relevant graphical view opens.

Saving a cam / preview Once a cam was edited within the project and is focused, changes can be per‐
manently applied in the project via the File ▶ Save (Ctrl+S) menu item.
The File ▶ Save All menu item also saves changes to cams and preview objects
currently not focused.

If a preview is saved, all the cams in the preview are saved as well!
When closing a project, all open document are automatically saved
(without confirmation)!

Copying a cam / preview A cam or a preview can be copied in the Project Explorer by highlighting and
selecting the menu item File ▶ Edit ▶ Copy.

Inserting a cam A cam or a preview can also be reinserted into the project once it has been
copied. Therefore, a "Cam Pool" node is highlighted and the copy of the cam
is inserted via the File ▶ Edit ▶ Insert menu item.

Renaming A Cam Pool, a cam or a preview can also be renamed by slowly clicking twice
on its name in the Project Explorer. An alternative is that the object is highlighted
in the Project Explorer and renamed via its context menu. A further option is to
call up the "Properties" dialog via the cam context menu, when the cam is open,
and change the name there.

Deleting A Cam Pool, a cam or a preview can be deleted via the context menu by high‐
lighting in the Project Explorer. An alternative is that the object is highlighted
and deleted using the <Del> key.
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8 Interacting with Bosch Rexroth Devices
8.1 Downloading Cams to Devices
8.1.1 General Information

The CamBuilder supports communication to different devices in the IndraWorks
project.
The devices either have to be online or in an offline parameterizable mode and
have to have an interface to the CamBuilder in order to use the following func‐
tions.
The "Download cam" dialog is started via the cam context menu in the Project
Explorer. The devices in the IndraWorks project, which are either online or in
an offline parameterizable mode, and support the downloading of cams, provide
an overview here of their parameters for cams.
The parameters have different symbols for the different operation modes:

Fig.8-1: Device symbols for different operation modes

8.1.2 Downloading Cams to Cam Table Parameters
If the focused cam is to be downloaded to cam table parameters, then a base
point table, with percentage values with at least 3 and at most the number of
points supported by the device, is created for the complete travel of the position
profile.
The following information is required for downloading into a cam table:
● Number of base points
● Distance factor for calculating the percentage values.
● Removing linear sections of the cam only applies to drives above a specific

version.
● The last data point in the table corresponds to X = 100% - (Yes / No) (table

format).
This setting only applies to drives; with controllers, the last data point al‐
ways corresponds to X = 100%.
There are only two different formats on the drive for specifying the calcu‐
lation of the X-values.

Assuming the number of base points is 1024:

Historically: The 100% is divided between 1024 + 1 points

 0,0000% = Point 1

 99,9024% = Point 1024

 100,0000% = Point 1

Current: The 100% is divided exactly between 1024 points

 0,0000% = Point 1

 99,9023% = Point 1023

 100,0000% = Point 1024
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If the cam has motion steps with time reference, the slave axis mo‐
tion is calculated using the entered master axis velocity. The dy‐
namic function is lost. The dynamics of the FlexSteps is also lost.

8.1.3 Downloading Cams to MotionProfile Parameters
If a cam is to be downloaded to MotionProfile parameters, it can only include
motion laws supported by the MotionProfile operation mode. The master axis
range has to be rotatorily fixed at 360 degrees.
No further settings are possible.

If the cam has motion steps with time reference, the slave axis mo‐
tion is calculated using the entered master axis velocity. The dy‐
namic limit values are lost here. The dynamics of the FlexSteps is
also lost.

8.1.4 Downloading Cams to FlexProfile Parameters
If a cam is to be downloaded to FlexProfile parameters, then it can only include
motion laws supported by the FlexProfile operation mode.
No further settings are possible.

8.1.5 Downloading Cams to CF Memory Card
If an MLC is online in the project, cams can also be stored on its Compact Flash
card.
Unlike with the parameters for cam tables, MotionProfiles and FlexProfiles,
there is no predefined format for cams on the CF card. The user has to specify
the desired format. The cam is saved as file with the name given in the Cam‐
Builder. If the file already exists, a query appears asking whether it should be
overwritten.

8.2 Uploading Cams from Devices
The CamBuilder supports communication to different devices in the IndraWorks
project.
The devices either have to be online or in an offline parameterizable mode and
have to have an interface to the CamBuilder in order to use the following func‐
tions.
The "Upload Cam" dialog is started via the context menu of a "Cam Pool" node
in the Project Explorer via "Upload Cam from Device". The devices in the
IndraWorks project, which are either online or in an offline parameterizable
mode, and support the uploading of cams, provide an overview here of the cams
ready for uploading.
The parameters have different symbols for the different operation modes:

Fig.8-2: Device symbols for different operation modes
The process for uploading cams is identical for all types of cam.
A specific name simply has to be entered when saving the cam in the
IndraWorks project. The cam is then converted into the neutral CamBuilder
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format. The editing of the cam is thus always identical in the CamBuilder, the
format of the cam is only of significance when downloading it onto a device.

8.3 Generating a PLC Function Block
The CamBuilder provides the option to generate a PLC code (in structured text)
for an FB. This code writes the cam defined in the CamBuilder into the Flex‐
Profile parameters of an MLC axis.
The PLC code generation for a cam is started via its context menu in the Project
Explorer via "Create PLC function block". An alternative is that the code gen‐
eration is started via the "PLC" button when the cam is open.

Fig.8-3: Generating PLC function blocks
If there is a folder named "General module folder" (IndraLogic) in the current
project, a new function block is automatically created for e.g. the selected
"Cam1" with the name "ChangeFlexSet_Cam1". The function block name con‐
sists of a prefix specified in the options dialog (see chapter 10.1  "CamBuilder
Options" on page 65) and the cam name (non-IEC conform characters are
replaced by the character "_").
If the folder "General module folder" does not exist in the current project, the
generated PLC code is only displayed in a display window. From this window,
the code text can be copied to the clipboard and can be used in other applica‐
tions.

Brief description of the function
block

The generated "ChangeFlexSet_Cam1" FB is used to load the motion steps
and events of the cam defined in the CamBuilder to a FlexProfile.

Interface Description

Fig.8-4: ChangeFlexSet_Cam1 FB

 Name Type Comment

VAR_IN_OUT Axis AXIS_REF Contains information regarding the axis for which the flex
profile set is to be exchanged.

VAR_INPUT Execute BOOL Starts the action at a rising edge

 SetNumber UINT Selecting FlexProfile (0 ... 3).

VAR_OUTPUT Done BOOL Data were applied.

 Active BOOL Processing of data runs after preprocessing is completed.

 Error BOOL Indicates that an error has occurred in the FB instance.

 ErrorID ERROR_CODE Brief indication of the error cause.

 ErrorIdent ERROR_STRUCT Detailed information regarding the error.

Fig.8-5: Interface of the FB ChangeFlexSet_Cam1
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Signal-time diagram

Fig.8-6: Signal-time diagram: MB_ChangeFlexProfileSet
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9 Importing and Exporting Cams
9.1 General Information

Cams can be imported into an IndraWorks project or exported from an
IndraWorks project using the CamBuilder. The following formats are supported
for these Import / Export functions:
● CamBuilder file (*.XML) 

Internal CamBuilder format.
Enables the unrestricted further editing of the cam in other CamBuilder
projects.

● Parameter file (*.PAR) 
Parameter file for drives and controls (e.g. IndraDrive and MLC).
Enables parameter files to be uploaded into the destination device using
IndraWorks or DriveTop for example. The cam is converted into a cam
table.

● Cam table (*.CSV)
The position values, velocity values, acceleration values and jerk values
of the cam are saved in a file that can be read by Excel. The cam is con‐
verted into a cam table. This ensures that it can also be read via DriveTop.

9.2 Exporting Cams
The export of a cam is started via the cam context menu in the Project Explorer
"Cam Pool" node.
If the cam is to be further edited in another project, it has to be exported in XML
format and imported into the other project.
If the cam is to be analyzed with the IndaSize tool, it has to be exported in XML
format and imported into IndraSize.
If the cam is to be sent to a drive using DriveTop, for example, the PAR format
or the CSV format can be used. The cam is exported and the exported file is
read with DriveTop and the cam table is send to the drive.
The CSV format is available for examining the position values, velocity values,
acceleration values and jerk values of a cam more closely.

As CamBuilder file (*.xml) Only the target location of the file has to be specified.
As a parameter file (*.par) The following information has to be provided for export as a parameter file:

● Device type - the drive or control type, on which the cam is to be stored.
● Cam table - the parameter, to which the cam is to be saved, e.g.drives of

the ECODRIVE family support two cams (P-0-0072 and P-0-0092).
● Remove linear components of the cam - if this function is set, the data sent

is modified. This function is only available with drives and also only with
specific firmware versions. You can find further information in the De‐
scription of Functions of the device used.

● Address - address of the drive or control on which the cam is to be saved
(limited from 0 - 100).

● The data point element in the table belongs to X: 100% (Yes/No) (table
format).

● Number of base elements (limited from 3 to 1024)
● Distance - factor for calculating the % values of the base element table.
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As a cam table (*.csv) The following information has to be provided when exporting the cam in CSV
format:
● Adding information - if this setting is not set, only the cam table will be

exported. Otherwise the following information is added:
– Date created
– CamBuilder version
– User-defined name
– Column headings

● Remove linear components of the cam - if this function is set, the data sent
is modified. This function is only available with drives and also only with
specific firmware versions. You can find further information in the De‐
scription of Functions of the device used.

● Backup in VisualMotion-8 format - automatically exports in VisualMo‐
tion-8-csv-file format. This setting automatically resets all other settings.

● The data point element in the table belongs to X: 100% (Yes/No).
● Number of base elements (limited from 3 to 1024)
● Distance - factor for calculating the % values of the base element table.
● Additional data - this setting enables the velocity profile, acceleration pro‐

file and the jerk profile to be exported as well.
● Field separator - specifies with which separator the values will be expor‐

ted. It is possible to choose between a comma and a semi-colon.

9.3 Importing Cams
The import of a cam is started via the context menu in the Project Explorer
"Cam Pool" node. The data to be imported has to be selected in an Open File
dialog.
No further entries are required when importing the cam in XML format.
SERCOS ASCII format files can include more than one parameter, which in‐
cludes a cam table. If a *.par file is selected for import, which includes more
than one cam table, then the user will be offered a selection of all the cam table
parameters found. The user can then select the cam table required from this
list.
The CamBuilder internally requires cam tables, the last Y data point of which
corresponds to X = 100%. If a CSV file or a PAR file is to be imported, then the
table format still has to be given. If the last Y value equals 0.xxx % or +-99.xxx
%, then a suggested last data point is automatically entered in the input field.
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10 CamBuilder Options and Cam Properties
10.1 CamBuilder Options

The Options dialog is opened via the Tools ▶ Options ▶ CamBuilder menu.
All the general settings can be entered here, which affect the entire CamBuilder
(all opened cams).
The options are sub-divided into two areas:

General options ● Minimum rotatory motion step length
● Minimal translatory motion step length
● Default rotatory motion step length
● Default translatory motion step length

Minimum motion step lengths can be defined for the slave axis. When a
change to a motion step is applied, the length of the focused step is
checked to see whether it is greater than this setting.
The defined default values are used when inserting new motion steps.

● FlexProfile FB name prefix
The name prefix is used to generate an PLC function block from a cam.
The name of the function block consists of the prefix and the cam name.

Graph options ● General Information
– Snap radius - Radius in pixel around the mouse pointer to select

objects
– Use grid position during editing - This option can be deactivated dur‐

ing editing by clicking on the <Ctrl> key
– Line thickness of the focused profile
– Line thickness of the inactive profiles
– Brightness of the focused motion steps
– Brightness of the inactive motion steps
– Line type of the coordinate grid

● Colors
You can select between two predefined color schemes and to modify them
in any way. The following colors can be adapted:
– Color of the position profile
– Color of the velocity profile
– Color of the acceleration profile
– Color of the jerk profile
– Color of the selected step (top)
– Color of the selected step (bottom)
– Color of the motion step limits
– Color of the coordinate grid
– Color of the graph background (top)
– Color of the graph background (bottom)

Every change is permanently saved and thus reproduced when the
CamBuilder is preset.
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10.2 Cam Properties
The "Properties" dialog of a cam is called up via the context menu of the focused
cam in the Project Explorer or via the CamBuilder toolbar. Settings for the fo‐
cused cam can be inputted here.

Opening Properties automatically loads the corresponding cam.

The properties to be edited here correspond to the first step of the wizard for a
new cam (refer to chapter 5  "Creating Cams and Preview Objects" on page
31).
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11 Printing Cams
The CamBuilder allows the user to print the different cams individually.
The following print settings can be selected via the "Print" context menu item
in the Project Explorer.
● Print the graphic output of the cam (Yes/No) - the current graphic output

will be printed. A cam has to be open in the workspace to allow this option
to be selected.

● Print the description of the cam (Yes/No) - the cam description will be
printed. The cam has to have a description for this option to be chosen.

● Print the application data of the cam (Yes/No) - the application data from
the application wizard will be printed. The cam has to have an application
wizard for this option to be chosen.

● Print the motion steps of the cam (Yes/No) - the data of the individual
motion steps (position, velocity, motion law, description, ...) will be printed.

● Print the extreme values of the cam (Yes/No) - the content of the extreme
values list will be printed.

● Print the cam table of the cam (Yes/No) - e.g. 1024 percentage values of
the slave axis position is printed.

To print or to view a preview, select at least one of the options.
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12 Motion Laws
12.1 General Information

The CamBuilder supports 36 different motion laws to define the motion between
the starting and end point of a motion step. Moreover, free cam tables can also
be imported to define the motion.
Further information about motion laws is given in the MLC FlexProfile docu‐
mentation.
The different motion laws provide different degrees of freedom in terms of limit
values and can be sub-divided into categories:

Fig.12-1: CamBuilder motion laws

12.2 Analytic Functions
12.2.1 General Information

The following motion laws enable a selection to be made on the basis of dif‐
ferent criteria.
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A high throughflow of goods is achieved by reducing damaging vibrations and
abrasion and noise is also minimized by this.

12.2.2 Rest in Rest
There are 12 Rest in Rest motion laws available. These motion laws are defined
only by the distance and the master axis range. Starting and end velocity are
0.
Rest in rest, Standstill
(up to CamBuilder 08VRS: linear rest)

Fig.12-2: Function: Rest in rest, standstill

Fig.12-3: Graph: Rest in rest, standstill
Rest in rest, Simple sine curve
Advantages
● Low velocity characteristic value
● Low acceleration characteristic value
● Low dynamic torque characteristic value
Disadvantages
● Acceleration step
● Vibrations, noise, abrasion

Fig.12-4: Function: Rest in rest, Simple sine curve
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Fig.12-5: Graph: Rest in rest, Sine curve (simple sinusoid)
Rest in rest, Inclined sine curve (Bestehorn sinoide)
Advantages
● Especially low jerk characteristic value
● Low vibration, ideal for high speeds
Disadvantages
● Velocity characteristic value, acceleration characteristic value and
● dynamic torque characteristic value are higher than with Polynomial 5th

order

Fig.12-6: Function: Rest in rest, Inclined sine curve (Bestehorn sinoide)
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Fig.12-7: Graph: Rest in rest, Inclined sine curve (Bestehorn sinoide)
Rest in rest, Acceleration-optimal inclined sine curve

Fig.12-8: Function: Rest in rest, Acceleration-optimal inclined sine curve
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Fig.12-9: Graph: Rest in rest, Acceleration-optimal inclined sine curve
Rest in rest, Moment-optimal inclined sine curve

Fig.12-10: Function: Rest in rest, Moment-optimal inclined sine curve
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Fig.12-11: Graph: Rest in rest, Moment-optimal inclined sine curve
Rest in rest, Sinoide of Gutman

Fig.12-12: Function: Rest in rest, Gutman sinusoid

Fig.12-13: Graph: Rest in rest, Gutman sinusoid
Rest in rest, Modified sine curve
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Advantages
● Ideal for high speeds
● Low velocity characteristic value
● Low acceleration characteristic value
● Low dynamic torque characteristic value
Disadvantages
● Jerk characteristic value is higher than with the inclined sine curve

Fig.12-14: Function: Rest in rest, Modified sine curve

Fig.12-15: Graph: Rest in rest, Modified sine curve
Rest in rest, Modified acceleration trapezoid
Advantages
● Especially low acceleration characteristic value
● Low inert forces
Disadvantages
● Jerk characteristic value is higher than with the inclined sine curve
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Fig.12-16: Function: Rest in rest, Modified acceleration trapezoid

Fig.12-17: Graph: Rest in rest, Modified acceleration trapezoid
Rest in rest, Quadratic parabola

Fig.12-18: Function: Rest in rest, Quadratic parabola
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Fig.12-19: Graph: Rest in rest, Quadratic parabola
Rest in rest, Polynomial 5th order
Advantages
● Low velocity characteristic value
● Low acceleration characteristic value
● Low dynamic torque characteristic value
● Low forces and torque
Disadvantages
● Jerk characteristic value is higher than with the inclined sine curve

Fig.12-20: Function: Rest in rest, polynomial 5th order
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Fig.12-21: Graph: Rest in rest, polynomial 5th order
Rest in rest, Polynomial 7th order

Fig.12-22: Function: Rest in rest, polynomial 7th order

Fig.12-23: Graph: Rest in rest, polynomial 7th order
Rest in rest, Polynomial 8th order
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Fig.12-24: Function: Rest in rest, Polynomial 8th order

Fig.12-25: Graph: Rest in rest, Polynomial 8th order

12.2.3 Rest in Velocity
Rest in velocity motion laws are used for impact- and jerk-free transition from
standstill to defined velocities.
Rest in velocity, Polynomial 5th order

Fig.12-26: Function: Rest in velocity, polynomial 5th order

Fig.12-27: Graph: Rest in velocity, polynomial 5th order
Rest in velocity, Polynomial 7th order

Fig.12-28: Function: Rest in velocity, Polynomial 7th order
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Fig.12-29: Graph: Rest in velocity, polynomial 7th order

12.2.4 Velocity in Rest
Velocity in rest motion laws are used for impact- and jerk-free transition from
defined velocities to standstill.
Velocity in rest, Polynomial 5th order

Fig.12-30: Function: Velocity in rest, polynomial 5th order

Fig.12-31: Graph: Velocity in rest, polynomial 5th order
Velocity in rest, Polynomial 7th order

Fig.12-32: Function: Velocity in rest, Polynomial 7th order

Fig.12-33: Graph: Velocity in rest, Polynomial 7th order
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12.2.5 Velocity in Velocity
Velocity in velocity motion laws are used for impact- and jerk-free transition from
defined velocities to other defined velocities.
Velocity in velocity, Constant velocity
(up to CamBuilder 08VRS: Analytic G-G / Linear interpolation)
The velocity is calculated using the specified distance and the given master
axis range. A constant velocity can be specified in the motion law "Extended,
linear velocity" (see chapter  "Resulting stroke" on page 87).

Fig.12-34: Function: Velocity in velocity, Constant velocity

Fig.12-35: Graph: Velocity in velocity, Constant velocity
Velocity in velocity, Polynomial 5th order

Fig.12-36: Function: Velocity in velocity, polynomial 5th order
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Fig.12-37: Graph: Velocity in velocity, polynomial 5th order
Velocity in velocity, Polynomial 7th order

Fig.12-38: Function: Velocity in velocity, polynomial 7th order

Fig.12-39: Graph: Velocity in velocity, polynomial 7th order
Velocity in velocity, Modified sine curve
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Fig.12-40: Function: Velocity in velocity, Modified sine curve

12.2.6 General Motion
Motion laws for general motion can always be used.
General motion, Polynomial 2nd order

Fig.12-41: Function: General motion, Polynomial 2nd order

Fig.12-42: Graph: General motion, Polynomial 2nd order
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General motion, Polynomial 3rd order

Fig.12-43: Function: General motion, Polynomial 3rd order

Fig.12-44: Graph: General motion, Polynomial 3rd order
General motion, Polynomial 4th order
(Special case with turning point displacement 0.57735 up to CamBuilder
08VRS: Polynomial 4th order (S))

Fig.12-45: Function: General motion, Polynomial 4th order
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Fig.12-46: Graph: General motion, Polynomial 4th order
General motion, Polynomial 5th order

Fig.12-47: Function: General motion, Polynomial 5th order

Fig.12-48: Graph: General motion, Polynomial 5th order
General motion, Polynomial 7th order
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Fig.12-49: Function: General motion, Polynomial 7th order

Fig.12-50: Graph: General motion, Polynomial 7th order
General motion, Polynomial 8th order

Fig.12-51: Function: General motion, Polynomial 8th order
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Fig.12-52: Graph: General motion, Polynomial 8th order

12.2.7 Extended Motion Laws
Resulting stroke

Extended, Linear velocity
(up to CamBuilder 08VRS: V-CAM Linear)

Fig.12-53: Function: Extended, Linear velocity
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Fig.12-54: Graph: Extended, Linear velocity
Extended, Linear acceleration
(up to CamBuilder 08VRS: A-CAM Linear)

Fig.12-55: Function: Extended, Linear acceleration

Fig.12-56: Graph: Extended, Linear acceleration
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Extended, Velocity 2nd Order (Starting acc. zero)
(up to CamBuilder 08VRS: V-CAM 2nd level (1)

Fig.12-57: Function: Extended, Velocity 2nd Order (Starting acc. zero)

Fig.12-58: Graph: Extended, Velocity 2nd Order (Starting acc. zero)
Extended, Velocity 2nd Order (End acc. zero)
(up to CamBuilder 08VRS: V-CAM 2nd level (2)

Fig.12-59: Function: Extended, Velocity 2nd Order (End acc. zero)
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Fig.12-60: Graph: Extended, Velocity 2nd Order (End acc. zero)

Extended, Resulting master axis range
These extended motion laws are special motion laws. They differ from the
known motion laws from the VDI guidelines by their new degrees of freedom.
While a standard motion law is clearly defined by the details of its left-hand and
right-hand limit values, the motion laws shown here enable even further differ‐
ent setting options, such as a required maximum velocity. In this case the
master axis range of the motion step is not required. Instead, this is produced
from the parameterization of the motion law and the specification of character‐
istic values. Thus, for example, acceleration-limited motion allows the distance,
starting and end velocities to be specified, but not the setting of a master axis
range. The latter, and thus also the duration of the motion step, is produced
from the values of maximum acceleration and maximum velocity, which can
also be specified.

Extended, Acceleration-limited mo‐
tion (trapezoid profile)

The trapezoid profile, often also known as a ramp profile, can be regarded as
the simplest form of path interpolation. If a path "s" should be traveled, it is
accelerated up to a specified traveling velocity in the first phase (acceleration
phase) using a given acceleration value. In the second phase (constant phase),
it is traveled with a constant velocity and finally in the third phase (braking
phase) it is decelerated with a predetermined delay. The role of path interpo‐
lation is to calculate the starting and end time points t1, t2 and t3 and the
individual runtimes T1, T2 and T3 from the preset acceleration values a1 and
a3 and the required velocity vm and the distance to be traveled "s". In the var‐
iation shown here, the required starting velocity v0 and end velocity v3 is also
taken into consideration.

Extended, Acceleration-limited mo‐
tion (sine curve)

With the sinoide profile, the starting and end velocity can be unequal to "0", and
have different acceleration factors a1 and a3 for the acceleration and braking
phase. Moreover, the special cases are also taken into consideration, in which
the starting velocity v0 is already greater than the required travel velocity vm.
The same also applies to the end velocity v3.
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Fig.12-61: Graph: Acceleration-limited motion (sine curve)
Extended, Jerk-limited motion (tra‐

pezoid profile)
The acceleration with jerk limitation applies to many motion tasks, for example,
to the transportation of fluids and to machines easily susceptible to vibration.
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Fig.12-62: Graph: Jerk-limited motion

Miscellaneous
Extended, Velocity-limited Polyno‐

mial 5th order
The Polynomial 5th order, known from the VDI, allows no control of the maxi‐
mum travel velocity. The motion law is sub-divided into three sections to solve
this problem. The middle section corresponds to a straight line with the required
velocity This is surrounded by two polynomials of the 5th order. This ensures
a smooth transition from the start to the traveling velocity and from the traveling
to the end velocity. The intersecting points between the first and second and
the second and third sections have to be determined. The points are selected
in such a way that no turning point is set for the two polynomials.
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Fig.12-63: Graph: Velocity-limited polynomial 5th order
Extended, Free of harmonics poly‐

nomial 5th order
The Free of harmonics polynomial 5th order recognizes and prevents possible
polynomial overvibration. How this is modified, depends on the combination of
the normalized velocity limit values. Four cases are produced. This motion law
cannot be used for combinations in which the normalized starting velocity V1
and the normalized end velocity V2 have different prefixes. This would mean
that the motion path would have a bend at a limit point, if it was not able to leave
the normalized range of 0 <= z <=1 and 0 <=f(z) <= 1.
● Case 1:

V0<=1 and V1<=1

Fig.12-64: Case 1
● Case 2:

V0<=1 and V1>1
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Fig.12-65: Case 2
● Case 3:

V0>1 and V1<=1

Fig.12-66: Case 3
● Case 4:

V0>1 and V1>1
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Fig.12-67: Case 4

12.3 Cam Tables
The slave axis motion of a motion step can be defined by means of a cam table.

Fig.12-68: Cam tables supported by the CamBuilder
In order to allocate a cam table to a motion step as a motion law using Cam‐
Builder, the menu item Cam Table ▶ Import Cam Table... has to be selected as
a motion law in the Motion Step Editor or an existing imported table will be
selected. A new Import dialog opens if a new table is to be imported.
There are three different options to select a cam table:

1. Importing a cam table from a cam in the current project
All the cams of the current project are listed and can be selected in a
selection dialog.
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2. Importing a cam table from a parameter file
3. Importing a cam table from a CSV file

With cams from the project, it is possible to state how many base points have
to be created (at least 3, at most 1024.) Moreover, the distance can be specified
for calculating the base points (0 corresponds to an automatic distance factor
- base points from 0% to 100%.) Following the import, a memory space number
has to be defined for the subsequent memory location on a device for this se‐
lected cam table.
A differentiation is made between cams, which consists of one or multiple mo‐
tion steps, when processing cam tables in the CamBuilder.

Cams consisting of one motion
step:

All cam table forms are supported here, that is to say cam tables whose end
value is greater or less than the starting value. Starting values not equal to 0
are also allowed, as are cam tables with the same starting and end points (e.g.
bell). The behavior here is identical to the MotionProfile, that is to say that points
from the cam table are simply multiplied by the distance (no offset, no scaling).

Cams consisting of multiple motion
steps:

Cam tables, the end point of which is greater than the starting point, are scaled
in such a way that they end at 100%. A starting point, which is not equal to 0%,
is offset to 0%. Thus, the entire cam table is automatically adapted to the dis‐
tance preset for the respective motion step. Cam tables with the same or
smaller end point than the starting point are not supported.
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13 Service and Support
Our service helpdesk at our headquarters in Lohr, Germany and our worldwide
service will assist you with all kinds of enquiries. You can reach us around the
clock - even on weekend and on holidays.

 Helpdesk
Service Hotline
Worldwide

Phone +49 (0) 9352 40 50 60 Outwith Germany please con‐
tact our sales/service office in
your area first.
For hotline numbers refer to
the sales office addresses on
the Internet.

Fax +49 (0) 9352 40 49 41

E-mail service.svc@boschrexroth.de

Internet
http://www.boschrexroth.com
You will also find additional notes regarding service, mainte‐
nance (e.g. delivery addresses) and training.

Preparing Information For quick and efficient help please have the following information ready:
● Detailed description of the fault and the circumstances
● Information on the type plate of the affected products, especially type co‐

des and serial numbers
● Your phone, fax numbers and e-mail address so we can contact you in

case of questions.
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